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0 SYSTEM REQUIREMENTS 

 

 Below are the minimum system requirements to install and run the DK-5000 Mieruzzo 

Basic Software: 

 

Processor Pentium 2 266MHz 

Operating System Windows 7, 8, 8.1, 10 

Disk Space Application:  50MB 

 Java Runtime Environment:  160MB 

Memory 1 GB 

 

Microsoft Excel and Windows are registered trademarks of Microsoft Corporation in the United 

States and/or other countries.  
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1 INSTALLING DK-5000 MIERUZZO BASIC SOFTWARE AND DRIVER 

 

 1.1 DK-5000 MIERUZZO BASIC SOFTWARE INSTALLATION 

  

1.1.1 Double-click to run the software installer. 

 

 

1.1.2 Select the language to use then click OK to continue with the software installation. 

 

 

1.1.3 The DK-5000 Mieruzzo Basic Software Setup Wizard will start.  Click Next to continue with 

the software installation. 
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1.1.4 Select the default installation folder or browse for a new location.  Click Next to continue with 

the software installation. 

 

 

1.1.5 Select the default location of program’s shortcut or browse for a new location.  Click Next to 

continue with the software installation.  
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1.1.6 Select whether to create or not to create the desktop icon for the software via the checkbox.  

Click Next to continue. 

 

 

1.1.7 Click Install to continue with the software installation. 
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A progress bar will show the installation progress. 

 

 

1.1.8 DK-5000 Series Device Driver Updater will open for the installation of necessary device 

driver.  Click Next to continue.  
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1.1.9 The following window will appear upon successful installation of the DK-5000 Series Device 

Driver.  Click Finish to continue. 

 

 

1.1.10 Click Finish to complete the software installation.  If Launch DK-5000 Mieruzzo Basic 

Software is checked, the software will automatically launch. 
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1.1.11 See below image for the default view of the DK-5000 Mieruzzo Basic Software. 

 

 

 

1.2 DK-5000 DEVICE DRIVER 

 

1.2.1 The correct DK-5000 Device Driver is installed together with the DK-5000 Mieruzzo Basic 

Software.   

In case there is a need to re-install the device driver, it can be found by selecting the correct 

driver located in the installation directory of the software.  The following message will be 

shown upon successful installation or update of the device driver. 
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2 CONNECTING AND DISCONNECTING A DK-5000 DEVICE 

  

2.1 CONNECT A DK-5000 DEVICE 

 

2.1.1 When a DK-5000 device is physically connected to the computer via a USB cable, click 

Device in the menu bar, then select Connection (Device > Connection) 

 

 

or click Connection button. 

 

 

2.1.2 The drop-down button will list all DK-5000 devices available with their corresponding Device 

ID and COM Port Connection.  If there are multiple items in the list, select the device you 

want to connect. 
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2.1.3 Click OK to connect to the selected DK-5000 device. 

When the software successfully connects to the selected device, the Title Bar will display the 

Device ID and COM Port Connection as shown below.   

 

  

 

The device details will also be shown in the lower left corner which will show the device 

model, Device ID, and the number of Records available in the device memory. 

 

Successful connection to a Type A or Type B device will show the Auto-Acquire page. 
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Successful connection to a Type C device will show the Acquire Present page. 

 

 

Successful connection to a Type D device will show the Auto-Acquire page. 
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2.1.4 If attempting to connect a new device while there are Records from a different device on 

display, a dialog will appear to confirm if Records will be saved before connecting to the new 

device.   

 

 

Select Yes to save the displayed Records. 

Select No to discard the Records on display and continue connecting to the new device. 

Select Cancel to abort connection to the new device. 

 

2.1.5 In cases where no DK-5000 device is detected, an error message will be shown. 

 

 

 

2.2 DISCONNECT A DK-5000 DEVICE 

 

2.2.1 Click Device in the menu bar, and then select Disconnect (Device > Disconnect).  
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A message will appear to confirm disconnection.  The DK-5000 can now be physically 

disconnected from the computer. 

 

 

  Warning! 

  Do not physically disconnect the DK-5000 device from the computer without a 

Disconnect command and confirmation that the device can be safely removed.  This will 

introduce a huge risk of the software not being able to detect re-connection of the DK-5000 

device or new connections of new DK-5000 devices.  

 

 

3 DATA COMMUNICATION WITH DK-5000 DEVICE 

 

3.1 AUTO-ACQUIRE DATA 

 

This function is available in Type A, Type B and Type D DK-5000 devices only.  Software will 

show the present data displayed on the DK-5000 device, and will automatically refresh every 1 

second.  

 

3.1.1 Click File in the menu bar, and then select Auto-Acquire (File > Auto-Acquire). 

 

 

Or click Auto-Acquire button. 
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3.1.2 A successful Auto-Acquire command will show the present data displayed on the DK-5000 

device, and the display will be automatically updated every 1 second.  The Last Update Time 

of the display is also shown. 

 

There are two display formats available for Type A and B. Click the corresponding tab to 

select the preferred display format. 

 

Format 1 shows the individual values of each Inputs on the left side, and the total of all 

Inputs or Inputs on the right side. 
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Format 2 shows the value of Input 1 on the left side, total and individual values of other 

Inputs in the middle, and total of all Inputs on the right side. 

 

 

For Type D, there is only one format for Auto-Acquire. A display legend is available to 

determine the status of each Input. (Green = High, Red = Low and Blue = Stand by). 

 

 



 
DK-5000 Series Mieruzzo Basic Software User’s Manual 

 
 
 

 

 15 

3.2 ACQUIRE PRESENT DATA 

 

This function is available in Type C DK-5000 devices only.  Software will show the present 

data displayed on the DK-5000 device.  

 

3.2.1 Click File in the menu bar, and then select Acquire Present Data (File > Acquire Present 

Data). 

 

 

or click Acquire Present Data button. 

 

 

3.2.2 A successful Acquire Present Data command will show the present data displayed on the 

DK-5000 device.  Additionally, it will update the number of Records shown in the device 

details. 
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3.2.3 This function can be executed only when device is in Count Mode.  If Acquire Present was 

attempted while device is in Standby Mode, an error message will be shown. 

 

 

 

3.3 HISTORICAL COUNT LIST 

This function is available for Type A, B and D DK-5000 devices. The software will show the 

list of ongoing count values from DK-5000 device. The view will automatically take data from the 

device every second for display according to user-set interval upon connection to the device. 

 

3.3.1 To view the Historical Count List, click the HCL Display tab from the Auto Acquire view. 

 

 

 

 

 



 
DK-5000 Series Mieruzzo Basic Software User’s Manual 

 
 
 

 

 17 

3.3.2 To start populating the list, select the Interval Type, either At Change or Time.  If Time is 

selected, the user needs to input the value in the textbox and select the unit of time (sec, min or hr) 

from the dropdown menu and then click Start button. 

 

3.3.3 The default Interval Type is set to At Change which means the table will update once      

there is a change in the current value displayed in the DK-5000 device.  

 

If At Change is selected, the textbox for time input and the dropdown menu for unit will be 

automatically disabled. 

 

 
 

3.3.4 To stop the table from updating, click Stop button. 

 

 
 

3.3.5 By default the History Count List table is set to Auto Scroll. This feature allows the table to 

automatically scroll to the latest table item. To enable and disable this feature, click Auto 

Scroll checkbox. 

 

 

3.3.6 To clear the History Count List table, click Clear button. 
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3.3.7 To export the table to Excel or CSV file, click the HCL Data Export button or right click on 

the table and click HCL Data Export. 

 

 
 

 

3.4 ACQUIRE ALL RECORDS 

 

This function enables the software to show all the records saved in the memory of DK-5000 

devices.  All Record details can be viewed and there is also an option to export Records to a 

spreadsheet or delete a specific Record. 

 

3.4.1 Click File in the menu bar, and then select Acquire All Records (File > Acquire All 

Records). 

 

 

Or click Acquire All Records button. 
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3.4.2 A successful Acquire All Records command will show all the records saved in the memory of 

the DK-5000 device.  Additionally, it will update the number of Records shown in the 

displayed device details. 

 

For a Type A device, all Records are listed in a single table. 
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For Type B and Type C devices, each Record is shown as a separate table.  Each table 

shows a list of all the logs inside that Record. 

 

 

For Type D devices, each record will also be shown as a separate table but with an 

additional table below, containing the summary of the main table. 

 



 
DK-5000 Series Mieruzzo Basic Software User’s Manual 

 
 
 

 

 21 

3.4.3 The software will display messages for three (3) conditions that indicate the status of 

available memory on the device. 

 

3.4.3.1  No Records In Memory 

A warning message will be displayed to indicate that Acquire All Records is attempted but 

there are no Records saved in the device memory. 

 

 

3.4.3.2  Device Memory Low 

“Memory Low” message will be displayed if device memory usage is between 80% - 100%. 

 

 

3.4.3.3  Device Memory Full 

“Memory Full” message will be displayed if 100% of device memory is used.  This serves as 

a warning to backup data by exporting to an .XLS or .CSV file, and free up device memory 

by deleting old Records.  When memory is full, the device will automatically delete the oldest 

Record to free up memory when additional memory for new Records is needed.   
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3.4.4 If Acquire All Records is pressed while the Records in the device are already on display 

because of a prior Acquire All Records command, the software will check if there are new 

Records or if there are changes in the device.  If the Records in the device do not match the 

Records on display, a dialog will appear to confirm if Records will be saved before acquiring 

Records.   

 

 

Select Yes to save the displayed Records.  Follow the export procedure. 

Select No to discard the Records on display and continue acquiring new Records. 

Select Cancel to abort acquiring all Records. 

 

 

3.5 DELETE A SPECIFIC RECORD IN DK-5000 DEVICE 

 

3.5.1 To delete a specific record in a Type A device, right-click on the Record to be deleted, and 

then select Delete Record. 
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To delete a Record in Type B, C or D devices, right-click on the Tab Title of the Record to be 

deleted, and then select Delete Record. 

 

 

3.5.2 A dialog will appear to confirm the requested command. 
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3.5.3 Click OK to delete selected record.  The following message will appear to confirm that the 

Record was successfully deleted. 

  

 

3.5.4 Delete Record will not proceed if the Records in the device do not match the Records on 

display.  A dialog will appear to confirm if the display will be updated by an automatic 

Acquire All Records command. 

 

 

Select Yes to update display by acquiring all Records in the device memory. 

Select No to abort Delete Record command. 

 

 

3.6 CLEAR ALL DATA IN DK-5000 DEVICE 

 

3.6.1 Click Device in the menu bar, select Device Settings, and then select Clear All Data 

(Device > Device Settings > Clear All Data). 
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3.6.2 A dialog will appear to confirm deletion of all records. 

 

 

3.6.3 Click OK to clear all Records in the device.  

All the Records in the device will be deleted and the records displayed in the software will 

also be cleared. 

 

Note: 

The DK-5000 device will proceed to Memory Recall Mode displaying “no data” to indicate 

that the memory is cleared of all data. 

 

3.6.4   

For Type B, C and D devices, the Clear All Data feature cannot be used when device is in 

Recording or Count Mode, respectively.  If Clear All Data is attempted during Recording or 

Count Mode, an error message will be shown. 
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4 Editing Labels 

 

 4.1 EDIT LABELS 

   

 This function allows the user to edit the default Input labels. These labels will be 

used in the Auto-Acquire and Acquire All tabs when displaying data from the device and 

also in the exported file. 

 

4.1.1 To edit Input labels, click Device from the menu bar then select Edit Labels.  

 

  

4.1.2 The Labels dialog will be shown and the textbox for each label will be enabled 

depending on the number of Inputs of the connected device. 

 

In this example, the connected device has 5 Inputs. 

 

Click OK button to apply the changes and Cancel button to discard the changes and 

close the Labels dialog. 
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4.1.3 Upon applying the changes in Input labels, the Auto-Acquire and Acquire All Records 

view will be updated. 

 Auto-Acquire View: 

   

   

  Acquire All Records View: 
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4.2 EXPORT LABELS 

This allows the user to save the labels into a CSV file. This CSV file can be shared 

and imported in case the user wants to use the labels again. 

  

4.2.1 To export labels, open the Labels dialog. Go to Device from the menu bar then click 

Edit Labels. 

 

 

4.2.2 After editing the labels, click Export button and the Save Dialog will show up with a 

default file name ‘Input_Labels’. The user can change the file name then select the 

location and click SAVE to save the CSV file. 
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4.3 IMPORT LABELS 

Once the CSV file of the labels has been exported, the user can import it and use it 

again. 

  

4.3.1 To import labels, open the Labels dialog. Go to Device from the menu bar then click 

Edit Labels. 

 

4.3.2 Click Import button then select the CSV file and click Open. 

 The labels from the CSV file will be displayed in the Labels dialog. 
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5 EXPORTING RECORDS TO A FILE 

 

5.1 EXPORT A SPECIFIC RECORD 

 

 This function enables saving a copy of selected Record to a spreadsheet.  This function is 

available in Type B, C and D DK-5000 devices only.  For Type A devices, please use the Export All 

Records function. 

 

5.1.1 To export a specific individual Record, right-click on the page to be exported, and then select 

Export Record or click the Export Record button, which is found on the lower-right corner 

of the page. 
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5.1.2 You can choose to save the record as an MS Excel Workbook (.XLS) or a comma separated 

value (.CSV) file. 

 

 

The default filename to be used follow the format below:  

Device ID_start timestamp_end timestamp.xls 

Device ID_start timestamp_end timestamp.csv 

 

 

5.2 EXPORT ALL RECORDS 

 

5.2.1 To export all records displayed, click File in the menu bar, and then select Export All 

Records (File > Export All Records). 
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Or click Export All Records button. 

 

 

5.2.2 You can choose to save the Records as an MS Excel Workbook (.XLS) or a comma 

separated value (.CSV) file. 

 

 

The default filename to be used follow the format below:  

Device ID_date & time of export.xls 

Device ID_date & time of export.csv 

 

If exported to Excel, each Record will be on a different sheet in one Excel file, while, if 

exported in CSV, each Record will be stored as individual CSV files. 
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6 CHANGING DEVICE SETTINGS 

 

6.1 SET DEVICE ID 

 

The software can be used to change the Device ID of the connected DK-5000 device.  The 

Device ID is a 3-digit user-programmable number which is used to identify different DK-5000 

devices. 

 

6.1.1 Click Device in the menu bar, select Device Settings, and then select Set Device ID 

(Device > Device Settings > Set Device ID). 

 

  

6.1.2 Type the desired 3-digit Device ID. 

 

 

6.1.3 Click OK to save selected Device ID. 

 

6.1.4 For Type B, C and D devices, this feature cannot be used when in Recording or Count 

Mode, respectively.  If the Device ID is attempted to be changed during Recording or Count 

Mode, an error message will be shown. 
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6.2 SYNCHRONIZE DK-5000 DEVICE TIME WITH SYSTEM TIME 

 

6.2.1 Click Device in the menu bar, and then select Sync Time (Device > Sync Time). 

 

 

6.2.2 A dialog will appear that shows the current time of the PC. 

 

 

6.2.3 Click OK to sync the time of DK-5000 device to system time. 

 

6.2.4 For Type B, C and D devices, this feature cannot be used when in Recording or Count 

Mode, respectively.  If time is attempted to be synced during Recording or Count Mode, an 

error message will be shown. 
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7 MISCELLANEOUS FUNCTIONS 

 

7.1 VIEW DEVICE FIRMWARE VERSION 

 

7.1.1 Click Device in the menu bar, and then select Firmware Version (Device > Firmware 

Version).  It will show the firmware version of the connected device. 

 

 

7.2 CHECK FOR SOFTWARE UPDATES 

 

7.2.1 Click Help in the menu bar, and then select Check for Updates (Help > Check for Updates).  

It will automatically search for available software updates. 

 

 

If no updates are available, it will show a message prompt below. 
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7.2.2 If there is no internet connection or if the software cannot connect to the update server, an 

error message will appear.  

 

 

 

7.3 VIEW SOFTWARE INSTRUCTION MANUAL 

 

7.3.1 Click Help in the menu bar, and then select Manual (Help > Manual).  It will open a copy of 

the DK-5000 Mieruzzo Software User’s Manual. 

 

 

7.4 VIEW SOFTWARE VERSION AND INSTALLATION DETAILS 

 

7.4.1 Click Help in the menu bar, and then select About DK-5000 Mieruzzo Basic Software (Help 

> About DK-5000 Mieruzzo Basic Software).  It will show the following window which tells the 

software build version and an option to see the software installation details. 
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8 FREQUENTLY ASKED QUESTIONS 

 

1. Why do I get a "no DK-5000 device detected" message when I click Connection even when my device is 

visibly connected? 

These are common reasons for not detecting a DK-5000 device, and possible solutions: 

 Make sure your device is connected and turned ON.  You cannot connect if the device is turned off. 

 Make sure that the PC recognizes your device.  If this is the first time you connected a DK-5000 

device, it'll take some time for windows to install the appropriate driver.  Please note that our 

software installation contains the drivers necessary for your DK-5000. 

 We received reports that changing the USB port to connect to help with the OS recognizing the 

device. 

 

2. Why do I get an "unknown device" error when I connect the DK-5000 device to my PC? 

These are 2 possible reasons for unknown device error: 

 Driver installation. Make sure that you've properly followed the software and driver installation. 

 Windows USB Stack issue. This is an issue with Windows' USB stack.  Try disconnecting then 

reconnecting the device, or restarting your PC. 

 

3. Why can’t I sync the time on my DK-5000 device via the Basic Software? 

It is possible that your device is in Recording or Count Mode.  There are restrictions to setting the time 

when the device is not on Standby Mode (for Type B, C and D devices).  Make sure you go to Standby Mode 

first before syncing the time. 

 

4. Why can’t I change the time on my DK-5000 device? 

It is possible that your device is in Recording or Count Mode. There are restrictions to setting the 

time when the device is not on standby mode (for Type B, C and D). Make sure you go to standby mode 

first before setting the time. 

 

5. Why can’t I change the Device ID on my DK-5000 device? 

You cannot change the Device ID on your DK-5000 device if it is connected to the DK-5000 Mieruzzo 

Software.  Use the Set Device ID function of the software to change the Device ID. 
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6. I already disconnected the device from the software, why can’t I change the Device ID on my DK-5000 

device? 

It is possible that your device is in Recording or Count Mode. There are restrictions to editing the 

Device ID when the device is not on Standby Mode (for Type B, C and D devices). Make sure you go to 

Standby Mode first before changing the Device ID. 

 

7. Why are my old records missing in the device memory? 

Your DK-5000 has limited memory and will erase the earliest record to free up space for new ones. To 

avoid this, please refer to the manual and save your records using our DK-5000 Mieruzzo Basic Software 

before clearing the device memory. 

 

8. Why don’t I get back to the default folder DK-5000 when I export my records?  

We have an initial folder DK-5000, but the software remembers the last folder where the user saved last 

export. You may choose not to use the DK-5000 folder. But you should be able to find it again under your 

Documents folder. 

 

9. The DK-5000 Mieruzzo Basic Software says there is a new update available, but I cannot update the 

software. 

If you are working behind a proxy server or a firewall, it could be that access to the update server is 

limited. Please contact your network administrator for help in correcting this by allowing TCP/IP access to 

software.line.com.ph at port 80. 

Intermittent internet connection may cause corruption in downloading the new version. If this happens, 

the software will report this error to you and continue with your current version. You may want to proceed 

with the update when you have a stable internet connection. 

There are reported incidences wherein update function does not work after reinstalling the software 

over a previous install. In this case, you will need to delete the entire program folder “C:\Program Files 

(x86)\Line Seiki\Mieruzzo\DK5000 Mieruzzo Software\” before reinstalling a new one. 

 

 

For more information, please visit www.lineseiki.com. 

 

 

 

 

 

 

 

http://www.lineseiki.com/
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